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Evaluating the AD7961 16-Bit, 5 MSPS PulSAR Differential ADC

FEATURES

Full-featured evaluation board for the AD7961

Versatile analog signal conditioning circuitry

On-board reference, reference buffers, and ADC drivers

System demonstration board compatible (EVAL-SDP-CH12)

PC software for control and data analysis of time and
frequency domain

EVALUATION KIT CONTENTS
EVAL-AD7961FMCZ evaluation board

ADDITIONAL EQUIPMENT AND SOFTWARE
NEEDED

System demonstration platform (EVAL-SDP-CH1Z)

Precision source

World-compatible, 12 V dc supply adapter (enclosed with
EVAL-SDP-CH1Z)

Power supply, +7 V/-2.5 V (optional)

USB cable

SMA cable

ONLINE RESOURCES

Documents

AD7961 data sheet

EVAL-AD7961FMCZ user guide
Required Software

EVAL-AD7961FMCZ evaluation software
Design and Integration Files

Schematics, layout files, bill of materials

SMA

SIGNAL SOURCE CONNECTOR

GENERAL DESCRIPTION

The EVAL-AD7961FMCZ is an evaluation board designed to
demonstrate the low power AD7961 performance (16-bit,

5 MSPS PulSAR® differential ADC) and to provide an easy-to-
understand interface for a variety of system applications. A full
description of the AD7961 is available in the data sheet and
should be consulted when utilizing this evaluation board.

The user PC software executable controls the evaluation board
over the USB through the Analog Devices, Inc., system
demonstration platform board (SDP), EVAL-SDP-CH1Z.

On-board components include the following:

ADR4520/ADR4540/ADR4550: high precision, buffered band
gap 2.048 V/4.096 V/5.0 V reference options

AD8031: reference buffer

ADA4899-1/ADA4897-1: a signal conditioning circuit with
two op amps and an option to use a differential amplifier
(ADA4932-1)

ADP7102, ADP7104, ADP124, and ADP2300: regulators to
derive necessary voltage levels on board

This evaluation board interfaces to the SDP board via a 160-pin
FMC connector. SMA connectors, JP1/JP4 and JP2/JP5, are
provided for the low noise analog signal source.

TO +12V WALL WART

11696-001

Figure 1. Setting Up the EVAL-AD7961FMCZ

PLEASE SEE THE LAST PAGE FOR AN IMPORTANT
WARNING AND LEGAL TERMS AND CONDITIONS.
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FUNCTIONAL BLOCK DIAGRAM
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EVALUATION BOARD HARDWARE

DEVICE DESCRIPTION

The AD7961 is a 5 MSPS, high precision, power efficient, 16-bit
ADC that uses SAR-based architecture and does not exhibit any
pipeline delay or latency. The AD7961 is specified for use with
5V and 1.8 V supplies (VDD1, VDD2). The interface from the
digital host to the AD7961 uses 1.8 V logic only.

The AD7961 uses an LVDS interface to transfer data
conversions. Complete AD7961 specifications are provided in
the product data sheet and should be consulted in conjunction
with this user guide when using the evaluation board. Full details
on the EVAL-SDP-CH1Z are available on the Analog Devices
website.

HARDWARE LINK OPTIONS

The function of the link options are described in Table 1. When
the user first receives the board, the default link setting on the
board are as shown in Table 1 (analog input/reference/power
supplies, and so on).

Table 1. Pin Jumper Descriptions

POWER SUPPLIES

The power (+12 V) for the EVAL-AD7961FMCZ board comes
through a 160-pin FMC connector, J7, from the EVAL-SDP-
CH1Z. The customer also has the option of using external
bench top supplies to power the on-board amplifiers. On-board
regulators generate required levels from the applied +12 V rail.

The ADP7102 (U18) supplies +7 V for the +Vs of the ADC
driver amplifiers (ADA4899-1 or ADA4897-1), external refer-
ence ADR4550 (U5), and ADR4540 (U8), while the ADP7104
(U10) delivers +5 V for VDD1 (U1), ADP2300 (U2), and
ADP124 (U3 and U12). The ADP2300 (U2), in turn, generates
—2.5V for the amplifier’s -Vs and the ADP124 (U3 and U12),
in turn, provides a 1.8 V for VDD2 and VIO (U1).

The +3.3 V supply for the EEPROM (U7) comes from the
EVAL-SDP-CHI1Z through a 160-pin FMC connector, J7. Each
supply is decoupled where it enters the board and again at each
device. A single ground plane is used on this board to minimize
the effect of high frequency noise interference.

Link Default Purpose

JP1,JP2 B to center | Connectsanalog inputs VIN+ and VIN- to the inputs of the ADC driverADA4899-1 or ADA4897-1. A to center sets the
fully differential path through ADA4932-1.

JP3,JP4 B to center | Connectoutputs from ADA4899-1 to inputs of AD7961. A to center set the fully-differential path through ADA4932-1.

JP5 Atocenter | Connectthe VCM output from AD7961 to AD8031.

JP7 Atocenter | Connects REFIN to 2.048 V external reference. B to center connects REFIN to GND.

JP8 B to center | Connects+7 V to amplifier +Vs.

JP9 B tocenter | Connects—2.5V to amplifier —Vs.

LK2,LK3 | Inserted Option to use external amplifier supplies + Vs and - Vs.

LK4 A Connects to +7 V coming from ADP7102.

LK5 B Connects to —2.5 V coming from ADP2300.

LK6 B Connects the output of VCM buffer to VCM of amplifier.

LK7 B Connects the +5 V output from ADR4550 to REF buffer AD8031.

Table 2. On-Board Connectors

Connector Function

J1,J2,J4,)5 SMA Analog Input. Connects the low noise analog signal source to the inputs of ADA4899-1 or ADA4932-1.

J3 3-Pin Terminal. This option is for using external bench top supplies. Apply external +Vs, —Vs, and GND to power amplifiers on
the EVAL-AD7961FMCZ board.

J6 6-Pin (2 x 3) Socket. This option is for interfacing with an external ADC driver board.

J7 160-Pin FMC 10 mm Male VITA 57 Connector. This connector mates with the EVAL-SDP-CH1Z board.
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Table 3. On-Board Power Supplies Description

Power Supply | Voltage Range (V) Purpose

+Vs +5Vto+7V ADP7104 (U10) and ADP7102 (U18) generate the necessary +5 V and +7 V, respectively, from
+12V coming from EVAL-SDP-CH1Z.The +7 V supply is recommended for on-board amplifier +Vs.
The +5 V supply is provided to VDD1 (U1), ADP2300 (U2), ADR4540/ADR4550 (U5 and U8), and
ADP124 (U3 and U12). The user also has an option to use an external bench top supply +Vs

through J3.
Vs -2Vto-5V ADP2300 generates —2.5 V for amplifier —Vs. The user also has an option to use an external bench
top supply —Vs through J3.
[+Vs to —Vs| 12V Maximum range of supply for correct operation.
VDD1 5Vv? AD7961 Analog Supply Rail.
VDD2, VIO 1.8V2 ADC Supply Rails.
'Dictated by ADA4899-1 supply operation.
“Refer to the AD7961 data sheet
SERIAL INTERFACE
The EVAL-AD7961FMCZ uses the serial interface connection e GPIO
to the EVAL-SDP-CH1Z. The EVAL-AD7961FMCZ operates e PPI
only in echo-clocked serial interface mode. This mode requires e Asynchronous parallel
three LVDS pairs (D+, CLK+, and DCO<) between each
AD7961 and the digital host. The EVAL-SDP-CH1Z board ANALOG INPUTS
features include This section provides information on the analog input options
e XILINX Spartan‘-6 FPGA and how these options can be configured as well as information
e DDR2 on how customers should connect their signal source.
e  Micron MT47H32M16Hr-25E:G The analog inputs applied to the EVAL-AD7961FMCZ board
—8 Mb x 16 bits x 4 Banks(512 Mb/64 Mb) are J1 and J2 SMA (push-on) connectors. These inputs are
e SRAM buffered with dedicated discrete driver amplifier circuitry
o ISSIIS61WV25616BLL-10BLI (U15 and U16 or U14) as shown in Figure 1.
-256 Kb x 16 bits (4 Mb/512 Kb) The circuit allows for different configurations, input range
e 1x 160-pin FMC-LPC connector (refer to the VITA 57 scaling, filtering, the addition of a dc component, use of a
specification) different op amp, and a differential amplifier and supplies.
e  Samtec ASP-134603-01 The analog input amplifiers are set as unity gain buffers at the
e Up to 1080 Mbps LVDS factory. The driver amplifiers (U14, U15, and U16) positive rails
e Single-ended LVCMOS are driven from +7 V (from ADP7102, U18) and negative rail
e  Power from —2.5 V; the other reference buffers (U4 and U11) positive

rails are driven from +7 V and negative rails are grounded;

e  Analog Devices, Inc., ADSP-BF527 Blackfin® processor
& P these could be changed to a different value as required.

e  Core performance up to 600 MHz
e 208-ball CSP-BGA package The range of supplies possible is listed in Table 3. The default

e 24 MHz CLKIN oscillator configuration sets both U15 and U16 at mid-scale generated
from a buffered reference voltage (VCM) of the AD7961 (U1).
The evaluation board is factory configured for providing either
a single-ended path or a fully differential path as described in

e 32 Mb flash memory
e Numonyx M29W320EB or
e Numonyx M25P32

Table 1.
e SDRAM memory
e Micron MT48LC16M16A2P-6A For dynamic performance, an FFT test can be performed by
~16 Mb x 16 bits (256 Mb/32 MB) applying a very low distortion source.
e 2 x 120-pin small foot print connectors For low frequency testing, the audio precision source can be
e Hirose FX8-120P-SV1(91),120-pin header used directly because the outputs on these are isolated. Set the
e Blackfin processor peripherals exposed outputs for balanced and floating. Different sources can be used
e SPI though most are single ended and use a fixed output resistance.
e SPORT Since the evaluation board uses the amplifiers in unity gain,
e TWI/I)C the noninverting input has a common-mode input with a series

49.9 Q resistor and it needs to be taken into account when
directly connecting a source (voltage divider).
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REFERENCE OPTIONS

The EVAL-AD7961FMCZ board allows three reference voltage
options. The user can select either the 5 V or 4.096 V option
using the solder link LK7 or the 2.048 V on-board reference
voltage using solder link JP7 as described in Table 1. The
various options for using this reference are controlled by the
EN1 and ENO pins (EN bits on software) as described in detail
in the AD7961 data sheet.

LAYOUT GUIDELINES

When laying out the printed circuit board (PCB) for the
AD7961, follow the recommended guidelines described in

this section to obtain the maximum performance from the
converter. Figure 30 to Figure 35 show the recommended layout
for the AD7961 evaluation board.

e  Solder the AD7961 exposed paddle (Pin 33) directly to
the PCB and connect the paddle to the ground plane of
the board using multiple vias.

e Decouple all the power supply pins (VDD1, VDD2 and
VIO) and the REF pin with low ESR and low ESL ceramic
capacitors, typically 10 uF and 100 nF, placed close to the
DUT (U1) and connected using short, wide traces to
provide low impedance paths and to reduce the effect of
glitches on the power supply lines.

e Use 50 Q single-ended trace and 100 Q differential trace.

e  Separate analog and digital sections and keep power supply
circuitry away from the AD7961.

¢  Avoid running digital lines under the device and crossover
of digital and analog signals because these couple noise
into the AD7961.

e Fast switching signals, such as CNV+ or CLK#, should
not run near analog signal paths.

e  Remove the ground and power plane beneath the input
(including feedback) and output pins of the amps (U14,
U15, and U16) as they create an undesired capacitor.

BASIC HARDWARE SETUP

The AD7961 evaluation board connects to the (EVAL-SDP-
CH1Z) system demonstration board. The EVAL-SDP-CH1Z
board is the controller board, which is the communication link
between the PC and the main evaluation board.

Figure 1 shows a photograph of the connections made between
the EVAL-AD7961FMCZ daughter board and the EVAL-SDP-
CHI1Z board.

1. Install the AD7961 software. Ensure the EVAL-SDP-CH1Z
board is disconnected from the USB port of the PC while
installing the software. The PC must be restarted after the
installation.

2. Before connecting power, connect the EVAL-AD7961FMCZ
board’s 160-pin FMC connector, J7, to the connector J4 on
the EVAL-SDP-CH1Z board. Nylon screws are included in
the EVAL-AD7961FMCZ evaluation kit and can be used to
ensure theEVAL-AD7961FMCZ and the EVAL-SDP-CH1Z
boards are connected firmly together.

3. Connect the +12 V power supply adapter included in the
kit to the EVAL-SDP-CH1Z.

4. Connect the EVAL-SDP-CH1Z board to the PC via the
USB cable. For Windows XP you may need to search for
the EVAL-SDP-CH1Z drivers. Choose to automatically
search for the drivers for the EVAL-SDP-CH1Z board if
prompted by the operating system.

5. Launch the EVAL-AD7961FMCZ software from the
Analog Devices subfolder in the Programs menu. The full
software installation procedure is detailed in the Evaluation
Board Software section.
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EVALUATION BOARD SOFTWARE

SOFTWARE INSTALLATION

The evaluation kit includes software is available to download
from the evaluation board page on Analog Devices website.
Click the setup.exe file to run the install. The default location
for the software is C:\Program Files (x86)\Analog
Devices\AD7960_61 Evaluation Software.

Install the evaluation software before connecting the evaluation
board and EVAL-SDP-CH1Z board to the USB port of the PC
to ensure that the evaluation system is correctly recognized when
connected to the PC.

There are two parts of the software installation process:

e AD7961 evaluation board software installation

e EVAL-SDP-CHI1Z board driver installation

Figure 3 to Figure 9 show the separate steps to install the
AD7961 evaluation software and Figure 10 to Figure 14 show
the separate steps to install the EVAL-SDP-CH1Z drivers.
Proceed through all of the installation steps to allow the
software and drivers to be placed in the appropriate locations.
Only after the software and drivers have been installed, should
you connect the EVAL-SDP-CHI1Z board to the PC.

* User Account Control ‘Sang Feacace
Do you want to allow the following program from an
-~/ unknown publisher to make changes to this computer?

Program name:  cetup.exe
Publisher: Unknown
File crigin: CD/DVD drive

¥ Show details

Helpm (!

wat al bt sunning this 4 |

ILie stionghy ded that you
nstalles Apph that run in the back d. such as visus-ccanning
utlitiez, might cause the instalier to take longer than avesage to complete”

Pleace wask wiia the instaber intisizes.

Figure 4. AD7961 Install Window 1
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11696-004

R o S
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Divectory for AD7360_61 Evaluation Software

IL\Flugan Files [#BEMAnalog Devices\ | Browse.. |
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[ cne e

Figure 5. AD7961 Install Window 2
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INSTALLATION NOTICE: THIS IS A CONTRACT. BEFORE YOU DOWNLOAD THE SOFTWARE
AMDIOR COMPLETE THE INSTALLATION PROCESS, CAREFULLY READ THIS AGREEMENT. BY
OOWNLOADING THE SOFTWARE ANDIOR CLICKING THE APPLICABLE BUTTON TO
COMPLETE THE INSTALLATION PROCESS, YOU CONSENT TO THE TERMS OF THIS

T AND YOU AGREE TO BE BOUND BY THIS AGREEMENT. IF YOU DO NOT WISH TO
BECOME A PARTY TO THIS AGREEMENT AND BE BOUND BY ALL OF ITS TERMS AND
CONDITIONS, CLICK THE APPROPRIATE BUTTON TO CANCEL THE INSTALLATION PROCESS,
DO NOT INSTALL OR USE THE SOFTWARE, AND RETURN THE SOFTWARE WITHIN THIRTY
(30) DAYS OF RECEIPT OF THE SOFTWARE (WITH ALL ACCOMPANYING WRITTEN MATERIALS,
ALONG YWITH THEIR CONTAINERS) TO THE PLACE YOL OBTAINED THEM. ALL RETURNS
SHALL BE SUBJECT TO NI'S THEN CURRENT RETURN POLICY.

The soltwace to which this Nationsl Instiuments keense appbes s ADTIE0_ET Evahistion Scltware.

@ | accept the License Ageement]

1 do not accept the Licerse Agreement.
[ < Back " et 33 [ Concel |

Figure 6. AD7961 Install Window 3

Start Installation
I Resiew The following summaty befote conlinuing

* M%_Eﬂ Evaluation Softwade Files

i Chand
* NI Secusily Update B7LELODW for cwi2dgrph ocx

Click the Nest bution to bagin inctallsfion. Chck the Bsck bulton to change the instalation selings.

[saveFie. | [ ccBack |[ mew>s [ Concal |

Figure 7. AD7961 Install Window 4
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Dverall Progeass: 53% Complele

¥ =
Vabdating nstall
@

< Bach Mt 33

Figure 8. AD7961 Install Window 5

Installation Complete |

The installer hes finished updating your system.

Welcome to the ADI SDP Drivers
2.1.960.2 Setup Wizard

This wizard will guide you through the installation of ADI S0P
Drivers 2.1.960,2.

1t is recommended that you close al other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Clhick Next to continue.

Figure 10. EVAL-SDP-CH1Z Drivers Setup Window 1

11696-008

11696-009

11696-010

Choose Install Location Ty
Choose the Folder in which to install ADI SDP Drivers 2.1.960.2, 67

Setup will install ADI SDP Drivers 2.1.960.2 in the following folder. To install in a different
fodder, chck Browse and select another Folder, Click Install to start the installation.

Space required: 249.3MB
Space available: 160.5G8

Plaase wait while ADI SDP Drivers 2.1,960.2 is being installad.

Instaliing Drivers
|

Extract: csariverInterface.dl... 100%

Execute: "C:\Windowslsystem32\csalrivernterface. i fsdent fi
+Driver Interface exit code =0

Cutput Folder: C:\Program Files (x86)\&nalog Devices|SOP DriversR2
Extract: WdfColnstaller01007.dll... 100%

Extract: WinUSBColnstaer. di.., 100%

Extract: adisdp_x64.cat... 100%

Extract: AdSdp_x64.inf... 100%.

Extract: dpinst.exe... 100%

Instaliing Drivers

Would you like to install this device software?

~  MName: Analog Devices, Inc. ADI Development Tooe...
_5‘ Publisher: Analog Devices BV,

[ Install | [ Don'tinstal

[T} Atways trust software from “Analog Devices BV.".

(@ You should only install driver soft from publish
which device seftware is safe to install?

you trust. How can [ decide

Figure 13. EVAL-SDP-CH1Z Drivers Setup Window 4
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{7 ADI SDP Drivers 2.1.960.2

Completing the ADI SDP Drivers
2.1.960.2 Setup Wizard

ADI SDP Drivers 2,1.960.2 has been installed on your
computer,

Click Finish to dose this wizard.

@ You must restart your computer to complete this operation.

If you need to install hardware now, shut down the computer. If you
choose to restait later, restart your computer befare unning any of this
software.

RestatLater |

[ Resar ] [

ShaDown | |

Figure 15. EVAL-SDP-CH1Z Drivers Setup Window 6

After installation is complete, connect the EVAL-AD7961FMCZ
to the EVAL-SDP-CH1Z as described in the Evaluation Board
Hardware section.

11696-015

11696-014

When you first plug in the EVAL-SDP-CH1Z board via the USB

cable provided, allow the new Found Hardware Wizard to run.
Once the drivers are installed, you can check that the board has
connected correctly by looking at the Device Manager of the
PC. The Device Manager can be accessed via

My Computer>Manage>Device Manager from the list of
System Tools. The EVAL-SDP-CH1Z board should appear
under ADI Development Tools.

This completes the installation.

Eile  Action View Help
e mDHm & 2%S

# 3y MPACHCHI-LOL
4 &F ADI Development Tools
&Y Analeg Dewices SDP-HL

3 Batteries
£) Bluetooth Radios
/& Cornputer
&% ControlVault Device
g Disk drives
B Display adapters
il DVD/CD-ROM drives
05 Hurnan Interface Devices

& g IDE ATASATAPT controliers
=5 Imaging devices

Figure 16. Device Manager

11696-016

LAUNCHING THE SOFTWARE

Once the EVAL-AD7961FMCZ and EVAL-SDP-CH1Z are
correctly connected to your PC, the AD7961 software can be
launched.

1. From the Start menu, select Programs>Analog Devices>
AD7960_61 Evaluation Software. The main window of
the software then displays (see Figure 19).
If the evaluation system is not connected to the USB port
via the EVAL-SDP-CH1Z when the software is launched, a
connectivity error displays (see Figure 17).

2. Connect the evaluation board to the USB port of the PC.

3. Wait for a few seconds and then click Rescan (see
Figure 18.

MNo matching systern found. Press Rescan to
retry or Cancel to abort,

If your SDP is recently connected, it may be in
the process of booting. Wait ~40secs and
Rescan,

[ Rescan ] [ Cancel ]

11696-017

Figure 17. Connectivity Error Alert 1

An SDP system was found, but no daughterboard was
detected,

Please power down the SDP system and ensure the

daughterboard is connected to the FMC connector
before repowering the SDP-H1. When SDP-H1 has
been repowered, run this software again,

11696-018

Figure 18. Connectivity Error Alert 2
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SOFTWARE OPERATION

This section describes the full software operation and all

windows that appear. When the software is launched, the panel
opens and the software searches for hardware connected to the

PC. The user software panel launches as shown in Figure 19.
The labels listed in this section correspond to the numbered
labels in Figure 19.

File Menu (Label 1)

The File menu, labeled 1 in Figure 19, offers the choice to
e  Save Captured Data: saves data to a .csv file

¢ Load Captured Data: loads data for analysis

¢  Take Screenshot: saves the current screen

e Print: prints the window to the default printer

e  Exit: quits the application

Edit Menu (Label 2)
The Edit menu, labeled 2, provides the following offering:

¢ [Initialize to Default Values: This option resets the
software to its initial state

Help Menu (Label 3)
The Help menu, labeled 3, offers help from the

¢  Analog Devices website
e  User Guide

e  Context Help

e About

Throughput (Label 4)

The default throughput (sampling frequency) is 5,000 kilo
samples per second (kSPS). The user can adjust the sampling
frequency, however there are limitations around the sample
frequency related to the SCLK frequency applied; the sample
frequency must be at least 500 kSPS. The AD7961 is capable

of operating a maximum sample frequency up to 5,000 kSPS.
If the user enters a value larger than the ability of the AD7961,

the software indicates this and the user must revert to the

maximum sample frequency.

Samples (Label 5)

Select the number of Samples to analyze, when running the
software; this number is limited to 131,072 samples.

Single Capture (Label 6) and Continuous Capture
(Label 7)

Single Capture performs a single capture whereas Continuous
Capture performs a continuous capture from the ADC.

Eval Board Connected (Label 8)
This indicator shows that the device connected.
Voltage Reference (Label 9)

The various options for using the external reference are
controlled by the Voltage Reference option. The default value
is set to 5 V (External Buffer). The other voltage reference

voltage options are 4.096 V and 2.048 V. It is reccommended to

use an on-board AD8031 as an external reference buffer.
Tabs
There are four tabs additional available for displaying the data

in different formats.
e  Waveform

e Histogram

e FFT

e  Summary

To exit the software, go to File>Exit.
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[ Anslog Devices ADTS60/AD7961 18/10-b1, SMSPS. . |
|| ER| "
182 3

AD7960/AD7961 Evaluation Software 3 ARNRS

| Configure | Waveform | Histagram | FFT | Summary | |5amp|es B El”[ single capture || Continuous Capture | 0
Eval Board Connected
AD7O6LFMCZ
8 woltage Reference

v (External Buffer) E

REFIN REF VCM VDD1 vDD2 VIO

ENO
EN1
EN2
CNV+, CNV- 5000 | Ksps
4
D+, D-
SERIAL
SAR VDS DCO+, DCO-
AD7960/AD7961 CLK+, CLK-
Faint
St
GND
|Ewaluation board initizlized Wersion 1.1.0.0 Busy .

11696-019

Figure 19. Setup Screen
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WAVEFORM CAPTURE

Figure 20 illustrates the Waveform tab. The 1 kHz sine-wave Note that Label 1 shows the Waveform Analysis which reports
input signal was used along with an on-board 5 V external the amplitudes recorded from the captured signal in addition to
reference. the frequency of the signal tone.

B (2 @
CONTROL CONTROL CONTROL
CURSOR ZOOMING PANNING

el . " —
[ Arviog Gevices AD7350
[File Edit Help

AD7960/AD7961 Evaluation Software \ > Fokr o

‘ Configure ‘ Waveform | Histogram I FFT | Surmmary ‘

Samples. 65536 El Sinale Capture ][Cnmt\nunu\capture] o I
\

65000
60000 {\ F’\
55000 ,l \'
50000 1‘
45000 l

40000 J
& 35000 ] J
=

!
|
!
|
\

5 30000 f l

- |
I
!
i

i

i

25000
20000 R
15000 l j i
10000 : -
f B 5| HE
SUUE ] 7 v ¥ v
a 5000 10000 15000 20000 45000 50000 55000 60000

\
|
|

‘ |
| 5
\ l
|
|

25000 30000 35000 40000
Time

waveform analysis

Pkopk Amplitude | 9.4664 |y (52039 | |sp Mean 1003410y, |32745.7] sp
Standard Deviation | 333428 |V |21851.5| 38
Min amplitude 7473297 | | 1750

) Frequency“ﬂ‘ééz | kHz

Data analysis complete

‘ersion 1.1.0.0

11696-020

Figure 20. Waveform Capture Tab
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DC TESTING—HISTOGRAM

The histogram is most often used for dc testing where a user
tests the ADC for the code distribution for dc input and
computes the mean and standard deviation, or transition noise,
of the converter, and displays the results. Raw data is captured
and passed to the PC for statistical computations.

To perform a histogram test,

1. Select the Histogram tab.

2. Click Single Capture or Continuous Capture.

Note that a histogram test can be performed without an
external source since the evaluation board has a buffered Vrer/2
source at the ADC input.

To test other dc values, apply a source to the J1/J2 inputs. You
may be required to filter the signal to make the dc source noise
compatible with that of the ADC.

ACTESTING—HISTOGRAM

Figure 21 shows the Histogram tab. This tests the ADC for the
code distribution for ac input and computes the mean and
standard deviation, or transition noise, of the converter and
displays the results. Raw data is captured and passed to the PC
for statistical computations.

To perform a histogram test,

1. Select the Histogram tab.

2. Click Single Capture or Continuous Capture.

Note that an ac histogram needs a quality signal source applied
to the input J1/J2 connectors.

Figure 21 shows the histogram for a 1 kHz sine wave applied to
the ADC input and the results calculated.

The Histogram Analysis (Label 1) illustrates the various
measured values for the data captured.

Analng Devices AD7960/AD° 18/16-bit, 5MSPS PulSAR Differential Al E:E
File Edit Help
Corfigure | waveform | Histogram | FFT | summary | Samples| 69536 [¢] [ Single Capture | [Continuaus Capture ] o
iRl
14000
12000
12000
11000
g 10000
5
£ 9000
3
5 =so0mn
7000
6000
5000
1 |
4000 I T ¥ 1 ]
a 5000 10000 15000 20000 25000 30000 35000 40000 45000 50000 55000 60000 65000
Bins
Histogram analysis
Max amplitude | 4.73343 W 63780 LSE Pk-pk amplitude  9.4664 W 62039 | gp
Min Amplitude | 4,733 w1750 LSB RMS  6.6927 W
DC Offset/Mean| -0.003410) y | 327457 LB Lse 15250 |y
Transition Noise | 3.33 W 218515 LSB Histograrn Width | 62039 Lse
Data analysis complete wersion 1.1.0.0 Busy .

11696-021

Figure 21. Histogram Capture Tab
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ACTESTING—FFT CAPTURE

Figure 22 shows the FFT tab. This tests the traditional ac
characteristics of the converter and displays a fast Fourier
transform (FFT) of the results. As in the histogram test, raw
data is captured and passed to the PC where the FFT is
performed displaying SNR, SINAD, THD, and SFDR.

To perform an ac test, apply a sinusoidal signal to the evaluation
board at the SMA inputs J1/J2. Very low distortion, better than
130 dB input signal source (such as audio precision) is required
to allow true evaluation of the part. One possibility is to filter
the input signal from the ac source. There is no suggested band-
pass filter, but carefully consider the choices.

Furthermore, if using a low frequency band-pass filter when

the full-scale input range is more than a few V p-p, itis
recommended to use the on-board amplifiers to amplify the
signal, thus preventing the filter from distorting the input signal.

Figure 22 displays the results of the captured data.

e Shows the input signal information (see Label 1)

e  Displays the fundamental frequency and amplitude in
addition to the 2" to 5™ harmonics (see Label 2)

e Displays the performance data, including SNR, dynamic
range, THD, SINAD, and noise performance (see Label 3)

( mnalug Devices AD7960/AD; bit, SMSPS Pu [ESNn e
- —
Eile Edit Help
[ corfigurs | waveform | Histagram | FFT | summary | Ssmples 65536 [+] | Single Capture | [Continuous Capture | i)
“HER |
o
-20
-40
_. 60
@
=
o -80
o
2
£ 100
H
-120
-140
'160“ Tt [ T ‘|| 1[1\ ‘\
-180
0 500000 1000000 1500000 2000000 2499923.7060
Frequency (Hz)
FFT 2nalysis
Max Amplitude 4.733 1 |63789 | LsB Fund. Frequency | 0.991821 kHz SHR| 93,4060 gp  Bin width 75,204
Min amplicude | -4.73297 v | 1750 LSB Fund. Amplitude | -0.49906! d4pFs THD -113.77 dB SFDR 108.28 |dB
Pk-pk Amplitude | 9.4664 |y 62039 LSB Dynamic Range 94,2509  dpFs SINAD 93,4476 4p
DC -0.003411 | 32746 | |sp RMS | 6.69274 |y Moise Floor | -138.53 | dg
Show Harmonic Content
y.4
Data analysis complete Wersion 1.1.0.0 Busy .
Lou
a 500000 1000000 1500000 2000000 2400023.7060
Frequency (Hz)
Harmonic Content
Frequency Amplitude
Fund | 0.9918: kHz  -0.499: dBFs
2nd |2.1362 |k -125.2 | dBFs
3rd |3.1281 |y, |-122.2 | dBFs
4th | 40436 | -123.1 | gaFs
5th | 50354 || -120.3 | ggpg
Shows FFT Analysis
= o
Data analysis complete Version 1.1.0.0 Busy @ 8
&
8
&

Figure 22. FFT Capture Tab
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SUMMARY TAB
Figure 23 shows the Summary tab which captures all the display information, including key performance parameters, such as
information and provides it in one panel with a synopsis of the SNR and THD.

([ relog Devices AOTSSO/ADT
File Edit Help

AD7960/AD7961 Evaluation Software ARNQS

Configure | Waveform I Histogram | Fp-—rl Summary ‘ Samples'__ 65536 [ Single Capture ] [Cnntmunus Capturel ﬂ I
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20000 =100
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10000
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1750 o 1000000 2499923.70
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Pk-pk Amp| 04664 |y Gzosg | LSB Dynamic Range |94 2509 éda

DC Offset/Mean | -0,00341t)y, 327457 | LSB SMNR Q3495§ =
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=1

Transition Nuwse}é,gaq.za -|V ‘"21351,5 LSB THD | -1137.777 |dBe

Docurrenc
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u] 20000 40000 60000 80000
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?Data analysis complete Version 1.1.0.0 BLisy i

11696-023

Figure 23. Summary Tab
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TROUBLESHOOTING

This section provides hints on how to prevent problems and
what to check when you encounter problems with the software
and hardware.

SOFTWARE

Review the following points regarding software:

e Always install the software prior to connecting the
hardware to the PC.

e Always allow the install to fully complete (the software
installation is a two-part process: installing the ADC
software and the SDP drivers). This may require a restart.

e  When you first plug in the EVAL-SDP-CH1Z board via
the USB cable provided, allow the new Found Hardware
Wizard to run. Though this may take time, do this prior
to starting the software.

e Ifthe board does not appear to be functioning, ensure that
the ADC evaluation board is connected to the EVAL-SDP-
CH1Z board and that the board is recognized in the
Device Manager, as shown in Figure 7.

e If connected to a slower USB port where the EVAL-SDP-
CH1Z cannot read quickly, a timeout error may occur.

In this case, it is advised not to read continuously or,
alternatively, to lower the number of samples taken.

¢  Note that when reading continuously from the ADC,
the recommended number of samples is up to 65,536.

HARDWARE

If the software does not read any data back,

e  With the +12 V wall wart plugged in to the EVAL-SDP-
CH1Z board, check to make sure that the voltage applied is
within the ranges shown in Table 3.

e  Using a DMM, measure the voltage present at +12 V and
the VAD] test points, which should read +12 V and 2.5V,
respectively. The +12V_FMC LED of the EVAL-
AD7961FMCZ board and LEDs of the EVAL-SDP-CH1Z
board (FMC_PWR_GO, SYS_PWR, FPGA_DONE,
BF_POWER, LEDO, and LED2) should all be lit.

e  Launch the software and read the data. If nothing happens,
exit the software.

e  Remove the +12 V wall wart and USB from the EVAL-
SDP-CH1Z board and then reconnect them and relaunch
the software.

e  Ifthis is not successful, confirm that the EVAL-
AD7961FMCZ and EVAL-SDP-CH1Z boards are
connected together so that the EVAL-AD7961FMCZ is
recognized in the Device Manager, as shown in Figure 7.

Note that when working with the software in standalone/offline
mode (no hardware connected), if you later choose to connect
hardware, first close and then relaunch the software.
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EVALUATION BOARD SCHEMATICS AND ARTWORK
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Figure 25. Schematic Page 2
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C1 AND C10 SHOULD BE PLACED BETWEEN REF AND REF_GND
AND BE PLACED VERY CLOSE TO THE DUT
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BILL OF MATERIALS

Table 4.

Name Part Description Manufacturer Part Number Stock Code

U1 16-bit, 5 MSPS, PulSAR Analog Devices AD7961BCPZ AD7961BCPZ
differential ADC

U2 Step-down regulator Analog Devices ADP2300AUJZ ADP2300AUJZ

U3 Adjustable LDO regulator Analog Devices ADP124CPZ-1.8 ADP124ACPZ-1.8-R7

U4 Op amp Analog Devices AD8031ARZ AD8031ARZ

us Voltage reference Analog Devices ADR4550BRZ ADR4550BRZ

u7 IC, EEPROM serial 2K, 24LC02, Microchip 24L.C02B-I/SN FEC 1196818
SOIC8 Technology

us Voltage reference Analog Devices ADR4540BRZ ADR4540BRZ

U9 IC translator, dual 4-bit, 16-DQFN | Fairchild FXL4TD245BQX Digi-Key

Semiconductor FXL4TD245BQXCT-ND

u10 Linear regulator ADJ, 20V, 300 Analog Devices ADP7104ACPZ-5.0 ADP7104ACPZ-5.0-R7
mA, ultralow noise, CMOS

Uil Op amp Analog Devices AD8031ARZ AD8031ARZ

u12 Adjustable LDO regulator Analog Devices ADP124ACPZ-1.8 ADP124ACPZ-1.8-R7

uU13 Voltage reference Analog Devices ADR4520BRZ ADR4520BRZ

u14 Differential ADC driver Analog Devices ADA4932-1 ADA4899-1YCPZ-R2

u15 Low noise, high speed amplifier Analog Devices ADA4899-1 ADA4899-1YRDZ
for 16-bit systems

u16 Low noise, high speed amplifier Analog Devices ADA4899-1 ADA4899-1YRDZ
for 16-bit systems

u1z Single INV Fairchild NC7504 FEC 1013809

u1is8 Linear regulator ADJ, 20V, 300 mA, | Analog Devices ADP7102ACPZ ADP7102ACPZ-R7
ultralow noise, CMOS

C1,C4,C8,C11,C16,C18,C19, Capacitor, 0805, 10 yF, 16V, 10% | Murata GRM219R61C106- FEC 1845747

C29, C42, C44, C60, C62 KA73D

C2,C3,C5,C6,C7,C9,C10,C12, | MLCC, 0603, X7R, 50V, 0.1 pF, Multicomp MCCA000255 FEC 1759122

C15,C17,C20,C27,C28,C31, 10%

(35, C40, C41, C43, C45, C46,

C52, C54,C56 to 59, C61

C14,C30 Capacitor, ceramic, 1 uF, 10V, TAIYO YUDEN LMK107B7105KA-T FEC 1683674
X7R, 0603, 10%

C21,C23 Capacitor, ceramic, 2.2 yF, 16 V, TAIYO YUDEN EMK212B7225KG-T FEC 1683654
X7R, 0805, 10%

C34, C36 to 38, C63, C64, C69, Capacitor, ceramic, 4.7 yF, 16 V, TAIYO YUDEN EMK212B7475KG-T FEC 1853520

Cc70 X7R, 0805, 10%

C22,C24 to0 26, C47,C50, C51, SMD capacitor, 10% TAIYO YUDEN - Do not place

C53,C55

C41,C45 Capacitor, 0508, 0.1 pF, 25V, X7R, | Murata LLL216R71E104MAOQ1L | FEC 1294646
+20%

C48, C49 MLCC, 0603, NP0, 50V, 56 pF, 5% | Multicomp MCCA000201 FEC 1759063

C66 Capacitor, 0805, 0.1 pF, 50V, X7R, | Kemet C0805C104K5RACTU FEC 1414664
10%

Cc71 Capacitor, ceramic, 10 pyF, 16V, TDK C3216X7R1C106M FEC 1844317
X7R, 1206, 10%

C76,C77 Capacitor, 0603, 100 pF, 50V, YAGEO CCO0603KRX7R9BB101 | FEC 722110
10% (Phycomp)
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Name Part Description Manufacturer Part Number Stock Code
D3 Diode Schottky 30V, 1A, Diodes, Inc PD3S130L Digi-Key
PWRDI-323 PD3S130LDITR-ND
R1, R2 Resistor, 0402, 100 R,0.0625 W, Multicomp MC 0.0625W 0402 1% | FEC 1358015
1% 100R

R4, R7,R9, R10, R12, R15, R20, SMD resistor, OR, 1% Multicomp MC 0.063W 0603 OR FEC 9331662

R21, R24, R26 to 30, R35, R48,

R50, R51, R59, R60

R6 Resistor, 0603, 16K9, 1% Multicomp MC 0.063W 0603 1% FEC 1170908
16K9

R7,R9,R13,R14, R16, R17, R22, Resistor, 0805, ORO, 0.1 W, 1% Multicomp MC 0.TW 0805 OR FEC 9333681

R24, R39

R37, R41 Resistor, 0603, 1K ,0.063, 1% Multicomp MC 0.063W 0603 1% FEC 9330380
1K

R11 Resistor, 0603, 35.7K, 1% Multicomp MC 0.063W 0603 1% FEC 1170942
35K7

R18 SMD resistor, 57.6K, 0% Multicomp MCTCO0525B5762T5E FEC 1575988

R19 Resistor, 0805, 12.1 K, 1% Vishay Draloric CRCWO080512K1FKEA | FEC 1469866

R31to R34 Resistor, 0402, 62.5MW, O R, 1% Multicomp MC 0.063W 0603 OR FEC 1357983

R36 Resistor, surge, 0805, 1%, 1 M Panasonic ERJPO6F 1004V FEC 1750796

R23, R25, R38, R40, R45, 54 to 56 | SMD resistor, 1% N/A N/A Do not place

R42 to 44, R49 Resistor, 499R, 0603, 0.1%, 0.1W Panasonic ERA3AEB4990V FEC 1810089

R52, R53 Resistor, 0805 33 R, 0.1% TE Connectivity CPFO805B33RE1 FEC 1697410

R57, R58 Resistor, 0603, 820 R, 0.1%, 0.1 W | Panasonic ERA3AEB821V FEC 1811397
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RELATED LINKS

Resource Description

AD7961 Data Sheet, 16-bit, 5 MSPS PulSAR Differential ADC

ADA4899-1 Product Page, ADA4899-1, Unity Gain Stable, Ultralow Distortion 1 nV/y/Hz Voltage Noise, High
Speed Op Amp

ADA4897-1 Product Page, ADA4897-1, 1 nV/y/Hz, Low Power, Rail-to-Rail Output Ampilifiers

ADA4932-1 Product Page, ADA4932-1, Low Power Differential ADC Driver

ADS8031 Product Page, AD8031, 2.7V, 800 pA, 80 MHz Rail-to-Rail /0 Amplifiers

ADP7102/ADP7104 Product Page, ADP7102/ADP7104, 20V, 300 mA/500 mA, Low Noise, CMOS LDO

ADP2300 Product Page, ADP2300, 1.2 A, 20V, 700 kHz/1.4 MHz, Nonsynchronous Step-Down Regulator

ADR4520/ADR4540/ADR4550
ADP124

Product Page, ADR4520/ADR4540/ADR4550, Ultralow Noise, High Accuracy Voltage References
Product Page, ADP124, 5.5V Input, 500 mA, Low Quiescent Current, CMOS Linear Regulators
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NOTES

12C refers to a communications protocol originally developed by Philips Semiconductors (now NXP Semiconductors).

ESD Caution
‘ ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection
‘m circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions

By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board"), you are agreeing to be bound by the terms and conditions
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) and Analog Devices, Inc.
("ADI"), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal,
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (i) permit any Third Party to access the Evaluation Board. As used herein, the term
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board.
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER'S POSSESSION OR USE OF
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI'S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable
United States federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.
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